
The session aims to support effective planning, resource estimation for implementation of preventive 
interventions for malaria control, integrating modern tools and techniques for  geo-enablement:  satellite 
imagery, GIS data and analytics to strengthen malaria prevention efforts.

Simex: Use of geospatial tools for Campaign 
Digitization 

2025 Alliance for Malaria Prevention Annual Partners Meeting and Campaign 
Digitalization Meeting



Session 1 (30 minutes):

Microplan and Geo Enablement: Country 
Experiences

Sharing country experiences on implementing microplanning and enablement 
strategies.

Facilitator: WHO GISC 

Session 2 (1 hour 45 minutes):

Practical Data and Analysis for Malaria 
Prevention

Hands-on demonstration of using satellite imagery, building footprints, population 
data, and accessibility analysis to digitalize health facilities and delineate catchment 
areas. 

Facilitator: GISC + Participants

Session 3 (30 minutes): 

Resource Estimation Exercise

Collaborative exercise focused on estimating resources needed for effective malaria 
prevention interventions.

Facilitator: GISC + Participants

Session 4 (15 minutes):

Discussion and Q&A

Open forum to discuss malaria control programs, including preventive interventions 
like bed-net distribution and vaccination campaigns, along with challenges and 
expectations from geo-enabled microplanning.

Facilitator: Participants

Agenda



Microplan and Geo-enablement : Country Experiences

The Alliance for Malaria Prevention Annual Partners Meeting and Campaign Digitalization Meeting
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• Supporting geospatial data 
and analytics

• Increasing the efficient use 
of GIS by the Member States 
and partners

• Promoting a GIS community 
of practice through training 
and technical expertise

WHO GIS Centre for Health Established in May 2022

Contact: gissupport@who.int

mailto:gissupport@who.int


Catchment 
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facilities

1. Mapping health facilities and 
immunization session sites

2. Catchment area delineation and 
basemap creation

3. Target population estimation and spatial 
distribution (including small-area 
estimation)

4. Geographic accessibility analysis and 
service optimization

5. Thematic mapping

6. Field and programme monitoring

Applications of geospatial data and technology for 
microplans



Microplan basemap creation - Participatory mapping 
workshop 

4 5Basemap
Collect & prepare 
basemap using satellite & 
contextual information

Scope & 
Planning
Define the area of extent 
and  the type of campaign

Workshop
Run a workshop with the 
field supervisors identifying 
their existing areas

Field validation
Field validation on the 
digitized  microplan 
boundaries for quality check 
and control

Mainstream
Using digitized microplans for 
operational planning, post 
campaign monitoring & resource 
allocation 

1 2 3



Microplan map creation
Digital microplans are created through 
a series of trainings and participatory 
workshops. Key components include: 

• Mapping health facilities and 
immunization session sites

• Mapping catchment area 
delineation and basemap creation

• Online dashboards created for all 
health zones

• Gathering and collation of 
additional spatial and tabular data 
needed for the microplans (e.g. 
storage and supplies)



High-resolution population estimates from secondary sources help improve the microplan target population 
estimates. Using spatial analysis and small-area estimation, official national data sources (e.g. census, 
survey, CRVS) can be triangulated and enhanced/projected to current year and targets.

GIS data used for improving population estimates may include:
Household-level data: 
Building footprints, survey 
data 

Modelled estimates:
(Worldpop, GRID3, Facebook, etc)

Small-area estimation: geo-
statistical analysis to fill gaps in 
national surveys

Improving target population estimates using geospatial data





Key benefits of geo-enablement

Enhanced Efficiency: GIS microplanning optimizes resource 
allocation and campaign logistics and value-for-money.

Improved Coverage: Near real-time data through the capturing 
of health facility catchments (sub-blocks) helps ensure all 
households are targeted, minimizing missed opportunities for 
reaching all populations.

Strengthened Monitoring: Geo-enabled dashboards provide 
leadership and decision-makers with near real-time progress 
tracking and immunization coverage estimates.

Sustainable Capacity and knowledge translation: Workshops 
with on-site GIS specialists strengthen capacities and ensure 
long-term sustainability and institutionalization.



GIS Microplanning Handbook and E-Learning Course

Planned translation in French
Geo-enabled Microplanning Handbook (link here)

https://drive.google.com/file/d/1ZEUaN5qtQyYmWwqSPJDUL4LaFl76p1Yr/view?usp=drive_link


One Campaign Management (OCM)
an integrated approach to geo-enabling immunization programmes 

The OCM approach equips health programmes with a flexible and custom workflow to plan, execute, and 
evaluate campaigns with precision, all while integrated with existing national health systems and 
infrastructure.

Pre-campaign

• Foundational geospatial 
data layers of 
population estimates, 
health boundaries and 
accessibility can be 
read into any campaign 
management and 
monitoring tool

• Develop digital 
microplans linked to 
supply chain and 
storage

• Create, edit, update 
and print microplans

• Capacity strengthening 
and GIS support

Intra-campaign

• Monitor and track 
microplan 
implementation and 
progress through 
dashboards

• Ability to update 
datasets in real-time 
through desktop and 
mobile applications

• Capacity strengthening 
and GIS support

Post-campaign

• Conduct post-campaign 
analysis of coverage 
and population 
reached, pre- and post-
campaign comparison 

• Visualization, editable 
access and 
maintenance of all 
datasets for all 
stakeholders (national 
and subnational data 
managers)

• Capacity strengthening 
and GIS support



Scaling up Geo-enabled Microplanning (2024-25)

2 Districts, 5M pop, 
3 months, 150K $

27 Districts, 72M pop, 
15 months, 1.7M $

77 Districts, 30M pop, 
(5yr plan), 7 dist. ( 

Y1, 200K $)
3 regions – 1M pop Province-East, South 

& Kandahar, 1M pop 2 Provinces, 1M pop 

Bangladesh Nepal Sudan Afghanistan Burundi

GMP is being scaled nationally 
in Bangladesh for the first 

time, proving its feasibility and 
effectiveness.

Bangladesh Country Office's 
work influenced Nepal’s 

strategy

A successful pilot tested 
cost-effective methods.

Nigeria

10 LGA – pilot and 
scale up

Proof of 
Concept

National 
Scaleup

National 
Rollout

Early stages of 
discussion 

Polio 
support

Bednet distribution Polio 
support

Early discussions with 
Sudan CO on implementing 
in Red Sea, Kassala, and 

Atbara

With D2D restrictions, 
focus on mapping health 
facilities, temp sites, and 

population modeling.

Supported Malaria bednet 
distribution with satellite 

imagery and pilot 
workshops

Initial talks with RO & CO 
on a full digital 

microplanning package

Components of 
Digital 

Microplan

The COVAX investments enabled the development of the Geo-
Enabled Microplanning (GMP) Handbook, setting a global standard 
and facilitating scale-up. Additionally, discussions are ongoing with 
Cameroon, Chad, Niger, CAR, and Somalia for implementation. Handboo

k



Bangladesh : Gaps Identified in Conventional Microplan

· Less active Immunization coverage and
logistics monitoring practice.

· Errors in session sites distribution, selecting
underserved areas, which leads to poor
planning.

· Unavailable of real-time digital session
planner for Monitoring and supervision.

· Difficult to identify Hard-to-reach and high-
risk areas.

· Repetitive information in the Microplan
("copy-paste": prepared without any
changes).



Maps – result of workshop



ORC added in 
Urban 

Immunization

2024 2023



Rehabilitation 
center and the new 
settlement of the 

homeless people of 
that union in 

another union 
(due to river 

erosion)



Practical Session on Data and Analysis for Malaria 
Prevention:

The Alliance for Malaria Prevention Annual Partners Meeting
Mövenpick Hotels & Residence
Nairobi, Kenya from 7 - 11 April 2025

- Form Groups
- At least 01 Laptop per Group
- Collect satellite Map
- A problem will be given 01 or 02 groups will be 

asked to  present



Burundi – Monitoring Change in Malaria Incidence – 2016 & 2022 

Malaria Atlas Project | Data

https://data.malariaatlas.org/maps?layers=Malaria:202406_Global_Pf_Parasite_Rate


Training on use of geospatial tools for microplanning of ITN distribution 
campaign
Digitalization of health facility catchment area and distribution points 

Main Objective
The main objective is to provide a brief introduction the process to 
demarcate catchment area on the paper map and digitalize using QGIS 
software as a part of digital micro-planning for the distribution of malaria 
prevention kits.

Specific Objectives
• Briefly present the five steps process of the microplanning

• Interactive exercise to demarcate respective catchment area
• Explore QGIS interface, some of its key menus and data format
• Learn how to import, visualize, and overlay different layers, as well as 

extract a subset of vector and raster data.





Importing shape (.shp) file into QGIS (1/3)
1

2 3

Step-by-Step Instructions to 
add vector layers:
1.Open your QGIS software
2.Go to the Layer menu and 
select Add Layer
3.Choose Add Vector Layer
4. Geopackage –add all layers



Adding satellite basemap trough XYZ Tiles in QGIS (2/4)
to Add a Satellite Basemap in QGIS:
1. In the Browser Panel (left side), right-click 
on XYZ Tiles and choose "New Connection…"
2. In the New XYZ Connection dialog:
• Name: Google Satellite (or whatever you 
prefer)
3. Under URL, copy-paste inside the following 
link: 
https://mt1.google.com/vt/lyrs=s&x={x}&y={
y}&z={z} 
4.Leave other settings as default, then 
click OK.
5. In browser panel, Expand XYZ Tiles and 
double click on Google satellite to display the 
satellite image

1

2,3 &4

5
https://mt1.google.com/vt/lyrs=s&x={x}&y={y}&z={z}

https://mt1.google.com/vt/lyrs=s&x=


Digitizing a catchment area into QGIS (2/4)

2 – Zoom on the image and digitize 
the catchment

Start digitizing:

1. Right-click your new layer (Team 
catchment Area 1)> Toggle Editing

2. In the toolbar, click on the polygone
and  digitize the catchment on the image.

1

2



Digitizing a catchment area in QGIS (2/4)
Finilize the digitalization process:

1. Right-click once at the end of the 
polygon to finish.

2. Fill in the attribute table info when 
prompted (Egs Id: 1  Team: 1)

3. Save and Stop Editing:
1.Click the Save Edits icon 💾 (disk with 
pencil).
2.Click Toggle Editing again to stop 
editing.

1 & 2

3



Training on use of geospatial tools for microplanning of ITN distribution 
campaign
- Estimating the buildings need reached per catchment area

The Alliance for Malaria Prevention Annual Partners Meeting
Mövenpick Hotels & Residence
Nairobi, Kenya from 7 - 11 April 2025



1⃣ Vector > Analysis Tools > Count Points in Polygon

Training on use of geospatial tools for microplanning of ITN distribution campaign
- Estimating the buildings need reached per catchment area

Obtain total counts of points 
in each team catchment area

2⃣ Select the corresponding polygons and points layers



Training on use of geospatial tools for microplanning of ITN distribution campaign
- Estimating the buildings need reached per catchment area

Obtain total counts of points 
in each team catchment area

A new layer Count is 
generated, representing the 
catchment areas.

The number labels shown are 
the total counts of 
points/buildings in each 
catchment area.

Right Click > Open Attribute 
Table > Stroll to the Right



Training on use of geospatial tools for microplanning of ITN distribution 
campaign
Accessibility Analysis

The Alliance for Malaria Prevention Annual Partners Meeting
Mövenpick Hotels & Residence
Nairobi, Kenya from 7 - 11 April 2025



Accessibility analysis

1. Physical accessibility analysis: Assess how physically 
accessible existing health services are to the target population 

1. Geographic coverage analysis: Part of the target population 
that would not receive care due to a shortage of capacity.

1. Referral analysis: Measure travel time and distances between 
health facilities/ supplier.

1. Zonal statistics: Identify percentage of the population having 
physical access to health services within a given time)

1. Scaling up analysis: Design and simulate different scenarios
aiming at scaling up the existing service delivery network.
(walking, motorized vehicles, etc.)

Accessibility analysis

Geographic coverage analysis

Referral analysis

Zonal statistics

Scale up analysis



AccessMod Next-generation, Web Version
(2022 release)

AccessMod 5.0, Standalone version 
(2017 release)

AccessMod

http://www.accessmod.org https://accessmod.openhexa.org/

http://www.accessmod.org/


AccessMod - Input geospatial data

Zones (admin division, 
health areas): GISC

Transportation network
HDX

Barriers to movement
HDX

Target population distribution
WorldPop UNPD adjusted, 2024

Land cover
Source: Sentinel-2 10m 2024

Digital elevation model 
SRTM 30m

Health Facility location
HDX Travel Scenario



Accessibility (120 min)

Population coverage by zonesProportion of population covered 

AccessMod – Outputs

Travel time distribution grid 
for different scenarios

Extent of travel time based catchment 
areas with location of added health 
facilities/distribution

Table

Walking+ motorized in main road

download



Result



Use of geospatial tools for microplanning of ITN distribution campaign
Resource estimation
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The table gives estimate of population reach within 2
hours travel time and number of houses in the
respective catchment areas. These are information
derived from model, is one of the techniques to
derive denominators for programme planning.
Participants are required to estimate resources based
on the tables.

• What should be best strategy to reach
maximum number of population in LLIN
distribution campaign?

• Estimate LLIN(Bale) for area
• Calculate storage requirements
• Decide whether any catchment area need

additional distribution sites or focused
communication in making inaccessible areas
or intensify monitoring visits.

• Explain how geo-enablement compliments
conventional micro-planning.


